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Print Selection Command

Use this command to print just the selected text of a document without displaying the print dialog.

Shortcut: F12



How to purchase Ecopad32 with a credit card
When purchased, you will receive a key (registration number) which will prevent the software from
shutting down after 30 days or 60 uses.

See Also:
Benefits of registration

CompuServe

GO SWREG
Register product # 8989
The purchase price will be charged to your regular CompuServe account.

CREDIT CARD ORDERS ONLY

You can order Ecopad32 ($25.00) with MasterCard, Visa, American Express, or Discover from Public 
Software Library by:

Calling 1-800-2424-PSL    (1-800-242-4775)
Calling 1-713-524-6394

FAX: 1-713-524-6398
CompuServe E-mail: 71355,470
Internet e-mail: 71355.470@compuserve.com

When you call PsL, be sure to ask for Ecopad32 (Product #11912).

Mail (CREDIT CARD ORDERS ONLY):

PsL
P.O. Box 35705
Houston, TX    77235-5705

PsL requires the following information:

Credit Card [    ] MasterCard    [    ]    Visa    [    ]    AMEX    [    ]    Discover    [    ]
Credit Card Number: ___________________________________________
Expiration Date ___________________________________________
Name On Card: ___________________________________________
Billing Address ___________________________________________

___________________________________________

When ordering with a credit card, be sure to ask for Ecopad32, product #11912, 
and include your credit card number and expiration date.

The author of this program cannot be reached at these numbers. 
Any questions about the status of the shipment of the order, 
refunds, registration options, product details, technical support, 
volume discounts, dealer pricing, site licenses, etc. must be 



directed to the following:

David T. Ossorio
325 S. Washington Ave. #166
Kent, WA    98032
USA

Internet:
davossorio@msn.com



Order Form
Version 3.50

Ecopad™ and Ecopad32™ are copyright © 1995,1996 by Azure D'or Software.
All rights reserved.

When purchased, you will receive a key (registration number) which will prevent this software 
from shutting down after 30 days or 60 uses. You will also receive a disk with the latest version of 
Ecopad32.

See Also:
Benefits of registration

This form can be printed by selecting File/Print Topic from the Help Menu above. If you are unable to print this form, then you can 
send the information below, along with payment, to the address given.

Please Print

Name:_______________________________________________________________________

Company:____________________________________________________________________

Address:_____________________________________________________________________

_____________________________________________________________________________

City:___________________________ State:______ Postal Code:_____________________

Country:_____________________________________________________________________

E-mail Address (Internet, CIS, AOL, etc.)___________________________________________

Where did you obtain your copy of Ecopad32?_____________________________________

Price: $25.00
Total Enclosed:______________________________

_______Check here if you would like your registration key e-mailed to you. (You will still receive an invoice and disk in the 
mail)

Company and personal checks are accepted as well as money orders. Purchase orders are accepted from companies and 
educational institutions. The amount shown above is in U.S. dollars. Checks must be in U.S. funds drawn on a U.S. bank.

Please make checks payable to: David T. Ossorio
Send To:

Azure D'or Software
David T. Ossorio
325 S. Washington Ave. #166
Kent, WA    98032
USA

Thank you for purchasing Ecopad32!



Fax Order Form

See Also:
Benefits of registration

Ecopad32™
PsL Product #11912

Name:__________________________________________________

Company: _______________________________________________

Address:_________________________________________________

___________________________________________________

City: ___________________________________________________

State:_______________ Postal Code:__________________________

Day Phone (optional):_______________________________________

Evening Phone (optional):___________________________________

Fax (optional):_____________________________________________

E-Mail: (optional):__________________________________________

Disk Type: 3 1/2”
Credit Card:
[    ] MasterCard    [    ]    Visa    [    ]    AMEX    [    ]    Discover    [    ]

Credit Card Number: ___________________________________________ Expires: _______

Name On Card: ___________________________________________

Billing Address ___________________________________________

___________________________________________
Price: $25.00
Shipping & Handling: (U.S): $0.00

Total Amount Paid:____________________________________________________

Signature: ___________________________________________

Fax this order form to: 1-713-524-6398



Benefits of Registration
When you order Ecopad32, you will receive a registration key which will prevent the software 
from shutting down after 30 days or 60 uses, whichever comes last. If the software has already 
expired, you can re-activate it with this number.

You will also receive a disk containing the latest version of Ecopad32.

You can use your registration key to register all future versions of Ecopad32, so updates are 
always free of charge (except for the cost of downloading).

Additionally, 2% of your total purchase price will be donated to St. Jude Children's Research 
Hospital. St Jude Children's Research Hospital is a non-profit organization which is dedicated to
treating and finding a cure for many types of childhood cancer. Your donation will help over 
4,000 children with cancer who are currently being treated at St. Jude, and will help the 
researchers there find more effective ways to cure childhood cancer. No family is ever charged 
for treatment at St. Jude. By purchasing Ecopad32, you will be helping to make a difference in 
the lives of thousands of children with cancer.

To order Ecopad32, select Help/About, and fill out and print the order form. 
Thank you for evaluating Ecopad32.



Disclaimer/Warranty/License

Ecopad32 for Windows95 and WindowsNT
Ecopad32™ is Copyright © 1995,1996 by Azure D'or Software.
All Rights Reserved.

The attached VENDINFO data record is hereby incorporated by reference. Any distribution satisfying all 
the distributions requirements in that data record is hereby authorized.

DISCLAIMER - AGREEMENT

This software is provided as is.
There are no warranties, expressed or implied.

AZURE D'OR DISCLAIMS ALL WARRANTIES RELATING TO THIS SOFTWARE, 
WHETHER EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE, AND ALL SUCH WARRANTIES ARE EXPRESSLY AND SPECIFICALLY 
DISCLAIMED. NEITHER AZURE D'OR NOR ANYONE ELSE WHO HAS BEEN 
INVOLVED IN THE CREATION, PRODUCTION, OR DELIVERY OF THIS SOFTWARE 
SHALL BE LIABLE FOR ANY INDIRECT, CONSEQUENTIAL, OR INCIDENTAL 
DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE SUCH SOFTWARE 
EVEN IF AZURE D'OR HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES OR CLAIMS. IN NO EVENT SHALL AZURE D'OR'S LIABILITY FOR ANY 
DAMAGES EVER EXCEED THE PRICE PAID FOR THE LICENSE TO USE THE 
SOFTWARE, REGARDLESS OF THE FORM OF CLAIM. THE PERSON USING THE 
SOFTWARE BEARS ALL RISK AS TO THE QUALITY AND PERFORMANCE OF THE 
SOFTWARE.

SOME STATES DO NOT ALLOW THE EXCLUSION OF THE LIMIT OF LIABILITY FOR
CONSEQUENTIAL OR INCIDENTAL DAMAGES, SO THE ABOVE LIMITATION MAY 
NOT APPLY TO YOU.

THIS AGREEMENT SHALL BE GOVERNED BY THE LAWS OF THE STATE OF 
WASHINGTON AND SHALL INURE TO THE BENEFIT OF AZURE D'OR AND ANY 
SUCCESSORS, ADMINISTRATORS, HEIRS, AND ASSIGNS, ANY ACTION OR 
PROCEEDING BROUGHT BY EITHER PARTY AGAINST THE OTHER ARISING OUT 
OF OR RELATED TO THIS AGREEMENT SHALL BE BROUGHT ONLY IN A STATE 
OR FEDERAL COURT OF COMPETENT JURISDICTION LOCATED IN KING 
COUNTY, WASHINGTON. THE PARTIES HEREBY CONSENT OT IN PERSONAM 
JURISDICTION OF SAID COURTS.

See Also:
How to purchase Ecopad32 with a credit card



Order form
Fax Order form



How to print more than 1 page of text on a single sheet of paper

Printing with Ecopad32 is easy. After you have loaded your document, select Options/Page 
Compression or click on the tree icon. You will be presented with a variety of printing and 
page compression options.    The options you set here will affect the way all documents in 
Ecopad32 are printed, and will be remembered the next time you run Ecopad32.



How to setup headers and footers

To set up headers and footers, select Options/Page Compression or click the tree icon, then 
select the headers/footers tab. The headers and/or footers entered here will print on all 
documents printed in Ecopad32, and will be remembered the next time you run Ecopad32.



How to display the current page number in a header or footer

To insert the current page number in a header or footer, type &P. The '&P' will be replaced in 
the header/footer with the current page number.



How to display the current filename in a header or footer

To insert the current filename in a header or footer, type &F. The '&P' will be replaced in the 
header/footer with the current filename.



Change the font used for screen display

To change the font used for screen display, select Options/Screen Font. The font you select 
here will be used for all documents you load into Ecopad32, and will be remembered the 
next time you run Ecopad32.



Change the font used for printing

To change the font used for printing, select Options/Page Compression. The font you select 
here will be used to print all documents you load into Ecopad32, and will be remembered the
next time you run Ecopad32.



Change the size of the font used for printing

To change the size of the printing font, select Options/Page Compression. You can then 
change the size of the printing font by adjusting the "Lines per compressed page" and/or 
"minimum number of letters per line" controls. The point size of the printing font will change 
in response to your adjusting these controls.



Running Ecopad32 from the Command Line

Ecoapd32 offers you a number of options when run from the command line. The basic 
format is:

ecopad32 [options] [filename]

[options] can be one or more of the following in any order (separated by spaces)

/p Prints [filename]

/p2 Prints (two sided) [filename]

/y1 Set layout to 1x1 (normal)
/y2 Set layout to 1x2
/y3 Set layout to 1x4
/y4 Set layout to 2x2
/y5 Set layout to 2x4

/d1 Draw lines
/d2 Draw pages
/d3 Draw nothing

/zn Set the size of the printing font to n points



Benefits of Purchasing Ecopad32

When you order Ecopad32, you will receive a registration key which will prevent the software 
from shutting down after 30 days or 60 uses, whichever comes last. If the software has already 
expired, you can re-activate it with this number.

You will also receive a disk containing the latest version of Ecopad32.

You can use your registration key to register all future versions of Ecopad32, so updates are 
always free of charge (except for the cost of downloading).

Additionally, 2% of your total purchase price will be donated to St. Jude Children's Research 
Hospital. St Jude Children's Research Hospital is a non-profit organization which is dedicated to
treating and finding a cure for many types of childhood cancer. Your donation will help over 
4,000 children with cancer who are currently being treated at St. Jude, and will help the 
researchers there find more effective ways to cure childhood cancer. No family is ever charged 
for treatment at St. Jude. By purchasing Ecopad32, you will be helping to make a difference in 
the lives of thousands of children with cancer.

To order Ecopad32, select Help/About, and fill out and print the order form. 
Thank you for evaluating Ecopad32.



Print Odd/Even Pages

Use this command to print two sided pages. It will print odd numbered pages, pause for you 
to turn the paper over, and then print even numbered pages.

Tip for two sided printing:    For printers that deposit pages face up you should use the 
following settings:

Even: First page to last
Odd: Last page to first



Print Odd Pages
Use this command to print only the odd numbered pages of the document.



Print Even Pages
Use this command to print only the even numbered pages of the document.



General Printing Options

Printing Order
You can print either first page to last or last page to first. Printing last page to first can be 
useful if your printed ejects pages in reverse order.

Note that if you select last page to first printing, you specify the range as you normally 
would. For example, to print pages 4,3,2 (in that order) of document, you would specify 
printing from page 2 to page 4. In other words, the "from" page should always be less than 
or equal to the "to" page.



Two Sided Printing Options

For two sided printing, you can specify the order of both the odd and even pages here. 



File menu commands

The File menu offers the following commands:

New Creates a new document.
Open Opens an existing document.
Save Saves an opened document using the same file name.
Save As Saves an opened document to a specified file name.
Print Prints a document.
Print 
Selection

Print the selected text in a document without displaying the print 
dialog box.

Print 
Preview

Displays the document on the screen as it would appear printed.

Print Setup Selects a printer and printer connection.
Send... Sends the active document through electronic mail.
Exit Exits Ecopad32.



Edit menu commands

The Edit menu offers the following commands:

Undo Reverse previous editing operation.
Cut Deletes data from the document and moves it to the clipboard.
Copy Copies data from the document to the clipboard.
Paste Pastes data from the clipboard into the document.
Delete Deletes selected text.
Select All Selects all text.
Insert Time Insert the current time.
Insert Date Insert the current date.
Insert Time/Date Insert the current Time/Date.
Word Wrap Turns word wrap on/off.
Convert Dos Text Converts the contents of the current document from the DOS (OEM) 

character set to the Windows (ANSI) character set.
Convert Windows Text Converts the contents of the current document from the Windows 

(ANSI) character set to the DOS (OEM) character set.
Delete 
LineID_EDIT_DELETELINE

Delete the current line



Delete Line

Use this command to delete the current line. This command is only available if there is no 
text selection.



Insert Time

This command will insert the current time into the document.



Insert Date

This command will insert the current date into the document.



Search menu commands

The search menu offers the following commands:

Find Find text
Find Next Finds the next occurrence of the specified

text
Replace Replaces one text string with another



View menu commands

The View menu offers the following commands:

Toolbar Shows or hides the toolbar.
         Status Bar Shows or hids the status bar.

Options menu commands

The Options menu offers the following commands, which control the way Ecopad32 
displays/prints all files.

File Extensions Lets you select to filename 
extensions which appear in the 
File/Open dialog box.

Display Font Lets you select the font used for 
screen display.

Printing Compression Lets you select the page layout and
page headers/footers.

Tabs Lets you select the tab size.
Auto Convert RTF Documents Automatically extract the text from

RTF documents
Page Setup Lets you select page margins and 

orientation.



Auto Convert RTF Documents

If you check this option, when loading a Rich Text Format (RTF) document, the text will be 
automatically extracted from the file.

If this option is unchecked, then RTF documents will load as plain text files (so that you can 
edit the formatting).



Help menu commands

The Help menu offers the following commands, which provide you assistance with this 
application: 

Help Topics Offers you an index to topics on 
which you can get help.

About Displays the version number of 
Ecopad32.



New command (File menu)

Use this command to create a new document in Ecopad32.

You can open an existing document with the Open command.

Shortcuts
Keys: CTRL+N



Open command (File menu)

Use this command to open an existing document.

You can create new documents with the New command.

Shortcuts
Keys: CTRL+O



File Open dialog box

The following options allow you to specify which file to open:
File Name
Type or select the filename you want to open.    This box lists files with the extension you 
select in the List Files of Type box. 
List Files of Type
Select the type of file you want to open. Note that Ecopad32 can open only ASCII text files.
Drives
Select the drive in which Ecopad32 stores the file that you want to open. 
Directories
Select the directory in which Ecopad32 stores the file that you want to open.
Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Save command (File menu)

Use this command to save the active document to its current name and directory.    When 
you save a document for the first time, Ecopad32 displays the Save As dialog box so you can
name your document.    If you want to change the name and directory of an existing 
document before you save it, choose the Save As command.

Shortcuts
Keys: CTRL+S



Save As command (File menu)

Use this command to save and name the active document.    Ecopad32 displays the Save As 
dialog box so you can name your document.    

To save a document with its existing name and directory, use the Save command.



Send command (File menu)

Use this command to send the active document through electronic mail.    This command 
presents a mail window with the active document attached to it.    You may then fill out the 
To: field, Subject: field, etc., and add text to the body of the message if you wish.    When you
are finished you may click the "Send" button to send the message.



File Save As dialog box

The following options allow you to specify the name and location of the file you're about to 
save:
File Name
Type a new filename to save a document with a different name.    Ecopad32 adds the 
extension you specify in the Save File As Type box.
Drives
Select the drive in which you want to store the document.
Directories
Select the directory in which you want to store the document.
Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Select All Command (Edit menu)

This command will select the entire document.



 Time/Date Command (Edit menu)

Inserts the current time/date into the document. If there is selected text, the selected text is 
replaced by the time/date.



Word Wrap Command (Edit menu)

Use this command to turn word wrap on/off. This does not affect printing, which always uses 
word wrap.



Convert Dos Text command (Edit menu)
This command converts DOS text, which uses the OEM character set, to Windows text, which uses the 
ANSI character set. This command is useful if you are loading a file which was created with a DOS text 
editor.



Convert Windows Text command (Edit Menu)
This command converts Windows text, which uses the ANSI character set, to DOS text, which uses the 
OEM character set. This command is useful if you will be loading a file into a DOS text editor.



File Extensions Command (Options menu)

The file extensions you enter here will be displayed in the File/Open dialog box. Ecopad32 
will remember the extensions you enter here and will also remember the last extension you 
used.



Display Font Command (Options menu)

Use this command to select the font used for screen display.

Shortcuts
Keys: F2



Printing Compression Command (Options menu)
Use this command to change page compression and header/footer text.



Page Setup Command (Options menu)

Use this command to select the margins and printer you wish to print with. Note that the 
margins you select here apply to the physical page, and not to compressed pages.



Tabs Command (Options menu)

Use this command to select the tab size (in inches) used in displaying/printing 
documents. You can select the default tab size by entering 0 here.



Page Compression Tab:

Layout
Select the number of compressed pages per actual page.

Lines of text per compressed page
Select the number of lines you wish to print on each compressed page. This will affect the 
size of the font used for printing. Note that this number is approximate.

Printing font
Select the font you wish to use for printing.

Page Separator
Compressed pages can be separated by lines, boxes, or blank space. This selection you 
make here is displayed in the preview window.

Print at least __ letters per line
Select the minimum number of letters (including spaces) you wish to have on each line of 
the compressed pages. This will affect the size of the font used for printing. Note that this 
number is approximate.



Headers/Footers

Select the headers/footers you wish to use for all documents in Ecopad32. The selections 
you make here will be remembered the next time you run Ecopad32.



Tabs Dialog Box

Select the tab size you wish to use for all documents. The selection you make here will be 
remembered the next time you run Ecopad32.



File Extensions Dialog Box

Select the file extensions that will be displayed in the File/Open dialog box.

You can also select the default "Save" extension. This is the extension that will automatically
be appended to a document when saved if you don't specify an extension.    For example, if 
you type "mydoc" in the file save dialog, the file will be saved as "mydoc.txt".



ASP Ombudsman Statement

ASSOCIATION OF SHAREWARE PROFESSIONALS (ASP)

The author of this software is a member of the Association of 
Shareware Professionals (ASP).

ASP wants to make sure that the shareware principal works 
for you.    If you are unable to resolve a shareware-related
problem with an ASP member by contacting the member directly,
ASP may be able to help.    The ASP Ombudsman can help you 
resolve a dispute or problem with an ASP member, but does not 
provide technical support for members' products.

Please write to the Ombudsman at 545 Grover Road,
Muskegon, MI 49442-9427 USA, FAX 616-788-2765 or send a 
CompuServe message via CompuServe Mail to ASP Ombudsman 
70007,3536.



1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four 
documents you closed.    Choose the number that corresponds with the document you want 
to open.



Exit command (File menu)

Use this command to end your Ecopad32 session.    You can also use the Close command on 
the application Control menu.    Ecopad32 prompts you to save documents with unsaved 
changes.

Shortcuts
Keys: ALT+F4



Undo command (Edit menu)

Use this command to reverse the last editing action, if possible.

Shortcuts
Keys: CTRL+Z or

ALT-BACKSPACE



Cut command (Edit menu)

Use this command to remove the currently selected data from the document and put it on 
the clipboard.    This command is unavailable if there is no data currently selected.

Cutting data to the clipboard replaces the contents previously stored there.

Shortcuts
Keys: CTRL+X



Copy command (Edit menu)

Use this command to copy selected data onto the clipboard.    This command is unavailable if
there is no data currently selected.

Copying data to the clipboard replaces the contents previously stored there.

Shortcuts
Keys: CTRL+C



Paste command (Edit menu)

Use this command to insert a copy of the clipboard contents at the insertion point.    This 
command is unavailable if the clipboard is empty.

Shortcuts
Keys: CTRL+V



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the 
most common commands in Ecopad32, such as File Open.    A check mark appears next to 
the menu item when the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The 
toolbar provides quick mouse access to many tools used in Ecopad32.

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be 
executed by the selected menu item or depressed toolbar button, and keyboard latch state. 
A check mark appears next to the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the Ecopad32 window.    To display or hide the 
status bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to 
navigate through menus.    This area similarly shows messages that describe the actions of 
toolbar buttons as you depress them, before releasing them.    If after viewing the description
of the toolbar button command you wish not to execute the command, then release the 
mouse button while the pointer is off the toolbar button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.
NUM The Num Lock key is latched down.
SCRL The Scroll Lock key is latched down.



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can
jump to step-by-step instructions for using Ecopad32 and various types of reference 
information.    

Once you open Help, you can click the Contents button whenever you want to return to the 
opening screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of 
Ecopad32.



Context Help command 

Use the Context Help command to obtain help on some portion of Ecopad32.    When you 
choose the Toolbar's Context Help button, the mouse pointer will change to an arrow and 
question mark.    Then click somewhere in the Ecopad32 window, such as another Toolbar 
button.    The Help topic will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

The title bar is located along the top of a window.    It contains the name of the application and 
document.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging their
title bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application
Name of the document
Restore button



Scroll bars

Displayed at the right and bottom edges of the document window.    The scroll boxes inside 
the scroll bars indicate your vertical and horizontal location in the document.    You can use 
the mouse to scroll to other parts of the document.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the
arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to 

the border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or 
dialog box with the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the Ecopad32 window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the
document Control menu closes only one window at a time.    You can close all windows at 
once with the Close command on the File menu.



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the 
Maximize or Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to 
or close an application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the 
following options:
Task List
Select the application you want to switch to or close.
Switch To
Makes the selected application active.
End Task
Closes the selected application.
Cancel
Closes the Task List box.
Cascade
Arranges open applications so they overlap and you can see each title bar.    This option does
not affect applications reduced to icons.
Tile
Arranges open applications into windows that do not overlap.    This option does not affect 
applications reduced to icons.
Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Find command (Edit menu)

Use this command to search an entire document for a word or phrase.



Replace command (Edit menu)

Use this command to replace a word or phrase in the current document.



Repeat command (Edit menu)

Use this command to repeat the last editing command carried out

Shortcut
Key: F3



Clear command (Edit menu)

This command deletes any text you have selected.



Modifying the Document

Editing text in Ecopad32 is exactly like editing text in Notepad.



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.





Print command (File menu)

Use this command to print a document.      This command presents a Print dialog box, where 
you may specify the range of pages to be printed, the number of copies, the destination 
printer, and other printer setup options.

Shortcuts

Toolbar:
Keys: CTRL+P



Print dialog box

The following options allow you to specify how the document should be printed:
Printer

This is the active printer and printer connection.    Choose the Setup option to change the
printer and printer connection.

Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Range
Specify the pages you want to print:
All Prints the entire document.
Selectio
n

Prints the currently selected text.

Pages Prints the range of pages you specify in the From and To boxes.
Copies

Specify the number of copies you want to print for the above page range.
Collate Copies

Prints copies in page number order, instead of separated multiple copies of each page.
Print Quality

Select the quality of the printing.    Generally, lower quality printing takes less time to 
produce.



Print Progress Dialog

The Printing dialog box is shown during the time that Ecopad32 is sending output to the 
printer.    The page number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Preview command (File menu)

Use this command to display the active document as it would appear when printed.    When 
you choose this command, the main window will be replaced with a print preview window in 
which one or two pages will be displayed in their printed format.    The print preview toolbar 
offers you options to view either one or two pages at a time; move back and forth through 
the document; zoom in and out of pages; and initiate a print job.



Print Preview toolbar

The print preview toolbar offers you the following options:
Print

Bring up the print dialog box, to start a print job.
Next Page

Preview the next printed page.
Prev Page

Preview the previous printed page.
One Page / Two Page

Preview one or two printed pages at a time.
Zoom In

Take a closer look at the printed page.
Zoom Out

Take a larger look at the printed page.
Close

Return from print preview to the editing window.



Print Setup command (File menu)

Use this command to select a printer and a printer connection.    This command presents a 
Print Setup dialog box, where you specify the printer and its connection.



Print Setup dialog box

The following options allow you to select the destination printer and its connection.
Printer

Select the printer you want to use.    Choose the Default Printer; or choose the Specific 
Printer option and select one of the current installed printers shown in the box.    You 
install printers and configure ports using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to 
the type of printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



Page Setup command (File menu)




